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Notice

© Keysight Technologies, Inc. 1983-2016
1400 Fountaingrove Pkwy., Santa Rosa, CA 95403-1738, United States

All rights reserved.

No part of this documentation may be reproduced in any form or by any means (including electronic storage
and retrieval or translation into a foreign language) without prior agreement and written consent from
Keysight Technologies, Inc. as governed by United States and international copyright laws.

Restricted Rights Legend

If software is for use in the performance of a U.S. Government prime contract or subcontract, Software is
delivered and licensed as "Commercial computer software" as defined in DFAR 252.227-7014 (June 1995),
or as a "commercial item" as defined in FAR 2.101(a) or as "Restricted computer software" as defined in FAR
52.227-19 (June 1987) or any equivalent agency regulation or contract clause.

Use, duplication or disclosure of Software is subject to Keysight Technologies' standard commercial license
terms, and non-DOD Departments and Agencies of the U.S. Government will receive no greater than
Restricted Rights as defined in FAR 52.227-19(c)(1-2) (June 1987). U.S. Government users will receive no
greater than Limited Rights as defined in FAR 52.227-14 (June 1987) or DFAR 252.227-7015 (b)(2)
(November 1995), as applicable in any technical data.
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QuestAgent search engine (c) 2000-2002, JObjects.

Portions of the code Copyright (c) 1990-1996

The Regents of the University of California. All rights reserved. Permission is hereby granted, without written
agreement and without license or royalty fees, to use, modify and distribute the Ptolemy software and its
documentation for any purpose, provided that the above copyright notice and the following two paragraphs
appear in all copies of the software and documentation.

In no event shall the University of California be liable to any party for direct, indirect, special, incidental, or
consequential damages arising out of the use of this software and its documentation, even if the University
of California has been advised of the possibility of such damage.

The University of California specifically disclaims any warranties, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose. The software provided hereunder is on an
"as is" basis and the University of California has no obligation to provide maintenance, support, updates,
enhancements, or modifications.

Portions of this product include the SystemC software licensed under Open Source terms, which are
available for download at http://systemc.org/. This software is redistributed by Keysight. The Contributors of
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the SystemC software provide this software "as is" and offer no warranty of any kind, express or implied,
including without limitation warranties or conditions or title and non-infringement, and implied warranties or
conditions merchantability and fitness for a particular purpose. Contributors shall not be liable for any
damages of any kind including without limitation direct, indirect, special, incidental and consequential
damages, such as lost profits. Any provisions that differ from this disclaimer are offered by Keysight only.

Motif is a trademark of the Open Software Foundation.
Netscape is a trademark of Netscape Communications Corporation.
UNIX is a registered trademark of the Open Group.

Microsoft, Windows, Windows NT, Windows 2000, and Windows Internet Explorer are registered trademarks
of Microsoft Corporation in the United States and other countries.

Pentium is a registered trademark of Intel Corporation.
Acrobat, PDF, and PostScript are registered trademarks of Adobe Systems Incorporated.

FLEXIm and FLEXnet are registered trademarks of Flexera Software LLC Terms of Use for Flexera Software
information can be found at http://www.flexerasoftware.com/company/about/terms.htm

Netscape Portable Runtime (NSPR), Copyright (c) 1998-2003 The Mozilla Organization. A copy of the Mozilla
Public License is at http://www.mozilla.org/MPL/

FFTW, The Fastest Fourier Transform in the West, Copyright (c) 1997-1999 Massachusetts Institute of
Technology. All rights reserved.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Cadence, Allegro, Assura, Dracula, SKILL, Spectre, and Virtuoso are registered trademarks of Cadence
Design Systems, Inc. in the United States and/or other jurisdictions.

Mentor, Mentor Graphics, Board Station, Calibre, and Expedition are registered trademarks of Mentor
Graphics Corporation in the United States and other countries.

SystemC is a registered trademark of Open SystemC Initiative, Inc. in the United States and other countries
and is used with permission.

Gradient, HeatWave and FireBolt are trademarks of Gradient Design Automation Inc.
The following third-party libraries are used by the NlogN Momentum solver:

Metis 4.0, Copyright © 1998, Regents of the University of Minnesota", http://www.cs.umn.edu/~metis,
METIS was written by George Karypis (karypis@cs.umn.edu).

Intel@ Math Kernel Library, http://www.intel.com/software/products/mkl
HSPICE is a registered trademark of Synopsys, Inc. in the United States and/or other countries.

DWG and DXF are registered trademarks of Autodesk, Inc. in the United States and/or other countries.
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MATLAB is a registered trademark of The MathWorks, Inc. in the United States and/or other countries.
SuperLU_MT version 2.0

SuperLU Copyright: Copyright © 2003, The Regents of the University of California, through Lawrence
Berkeley National Laboratory (subject to receipt of any required approvals from U.S. Dept. of Energy). All
rights reserved.

SuperLU Disclaimer: THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

7-zip
7-Zip Copyright: Copyright (C) 1999-2009 Igor Pavlov.
Licenses for files are:

1. 7z.dll: GNU LGPL + unRAR restriction.
2. All other files: GNU LGPL.

7-zip License: This library is free software; you can redistribute it and/or modify it under the terms of the
GNU Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is distributed in the hope that it will be useful,but
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA.

unRAR copyright: The decompression engine for RAR archives was developed using source code of unRAR
program.All copyrights to original unRAR code are owned by Alexander Roshal.

unRAR License: The unRAR sources cannot be used to re-create the RAR compression algorithm, which is
proprietary. Distribution of modified unRAR sources in separate form or as a part of other software is
permitted, provided that it is clearly stated in the documentation and source comments that the code may
not be used to develop a RAR (WinRAR) compatible archiver.

7-zip Availability: http://www.7-zip.org/
AMD Version 2.2
AMD Notice: The AMD code was modified. Used by permission.

AMD copyright: AMD Version 2.2, Copyright © 2007 by Timothy A. Davis, Patrick R. Amestoy, and lain S.
Duff. All Rights Reserved.
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AMD License: Your use or distribution of AMD or any modified version of AMD implies that you agree to this
License. This library is free software; you can redistribute it and/or modify it under the terms of the GNU
Lesser General Public License as published by the Free Software Foundation; either version 2.1 of the
License, or (at your option) any later version. This library is distributed in the hope that it will be useful, but
WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby
granted to use or copy this program under the terms of the GNU LGPL, provided that the Copyright, this
License, and the Availability of the original version is retained on all copies.User documentation of any code
that uses this code or any modified version of this code must cite the Copyright, this License, the Availability
note, and "Used by permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice that the code was
modified is included.

AMD Availability: http://www.cise.ufl.edu/research/sparse/amd

UMFPACK 5.0.2

UMFPACK Notice: The UMFPACK code was modified. Used by permission.

UMFPACK Copyright: UMFPACK Copyright © 1995-2006 by Timothy A. Davis. All Rights Reserved.

UMFPACK License: Your use or distribution of UMFPACK or any modified version of UMFPACK implies that
you agree to this License. This library is free software; you can redistribute it and/or modify it under the
terms of the GNU Lesser General Public License as published by the Free Software Foundation; either version
2.1 of the License, or (at your option) any later version. This library is distributed in the hope that it will be
useful, but WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS
FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License for more details. You should have
received a copy of the GNU Lesser General Public License along with this library; if not, write to the Free
Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA Permission is hereby
granted to use or copy this program under the terms of the GNU LGPL, provided that the Copyright, this
License, and the Availability of the original version is retained on all copies. User documentation of any code
that uses this code or any modified version of this code must cite the Copyright, this License, the Availability
note, and "Used by permission." Permission to modify the code and to distribute modified code is granted,
provided the Copyright, this License, and the Availability note are retained, and a notice that the code was
modified is included.

UMFPACK Availability: http://www.cise.ufl.edu/research/sparse/umfpack UMFPACK (including versions
2.2.1 and earlier, in FORTRAN) is available at http://www.cise.ufl.edu/research/sparse. MA38 is available in
the Harwell Subroutine Library. This version of UMFPACK includes a modified form of COLAMD Version 2.0,
originally released on Jan. 31, 2000, also available at http://www.cise.ufl.edu/research/sparse. COLAMD V2.
0 is also incorporated as a built-in function in MATLAB version 6.1, by The MathWorks, Inc. http://www.
mathworks.com. COLAMD V1.0 appears as a column-preordering in SuperLU (SuperLU is available at
http://www.netlib.org). UMFPACK v4.0 is a built-in routine in MATLAB 6.5. UMFPACK v4.3 is a built-in
routine in MATLAB 7.1.

Errata
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The ADS product may contain references to "HP" or "HPEESOF" such as in file names and directory names.
The business entity formerly known as "HP EEsof" is now part of Keysight Technologies and is known as
"Keysight EEsof". To avoid broken functionality and to maintain backward compatibility for our customers,
we did not change all the names and labels that contain "HP" or "HPEESOF" references.

Qt Version 4.8.4
Qt Notice: The Qt code was modified. Used by permission.

Qt Version 4.8.4, Copyright (C) 2014 Digia Plc and/or its subsidiary(-ies). All Rights Reserved. Contact:
http://www.qt-project.org/legal

Qt License: http://qt-project.org/doc/qt-4.8/lgpl.html. Your use or distribution of Qt or any modified version
of Qt implies that you agree to this License. This library is free software; you can redistribute it and/or modify
it under the terms of the GNU Lesser General Public License as published by the Free Software Foundation;
either version 2.1 of the License, or (at your option) any later version. This library is distributed in the hope
that it will be useful, but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU Lesser General Public License
for more details. You should have received a copy of the GNU Lesser General Public License along with this
library; if not, write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor, Boston, MA 02110-
1301 USA Permission is hereby granted to use or copy this program under the terms of the GNU LGPL,
provided that the Copyright, this License, and the Availability of the original version is retained on all copies.
User documentation of any code that uses this code or any modified version of this code must cite the
Copyright, this License, the Availability note, and "Used by permission." Permission to modify the code and to
distribute modified code is granted, provided the Copyright, this License, and the Availability note are
retained, and a notice that the code was modified is included.

Qt Availability: http://www.qgtsoftware.com/downloads

Patches Applied to Qt can be found in the installation at: $HPEESOF_DIR/prod/licenses/thirdparty/qt
/patches.

You may also contact Brian Buchanan at Keysight Inc. at brian_buchanan@keysight.com for more
information.

The HiSIM_HV source code, and all copyrights, trade secrets or other intellectual property rights in and to
the source code, is owned by Hiroshima University and/or STARC.

HDF5

HDF5 Notice: The HDF5 code was modified. Used by permission.

HDF5 Copyright: Copyright 2006-2013 by The HDF Group.

HDF5 License:

Copyright Notice and License Terms for HDF5 (Hierarchical Data Format 5) Software Library and Utilities
HDF5 (Hierarchical Data Format 5) Software Library and Utilities

Copyright 2006-2013 by The HDF Group.
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NCSA HDF5 (Hierarchical Data Format 5) Software Library and Utilities
Copyright 1998-2006 by the Board of Trustees of the University of Illinois.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted for any
purpose (including commercial purposes) provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and
the following disclaimer in the documentation and/or materials provided with the distribution.

3. In addition, redistributions of modified forms of the source or binary code must carry prominent
notices stating that the original code was changed and the date of the change.

4. All publications or advertising materials mentioning features or use of this software are asked, but not
required, to acknowledge that it was developed by The HDF Group and by the National Center for
Supercomputing Applications at the University of Illinois at Urbana-Champaign and credit the
contributors.

5. Neither the name of The HDF Group, the name of the University, nor the name of any Contributor may
be used to endorse or promote products derived from this software without specific prior written
permission from The HDF Group, the University, or the Contributor, respectively.

libpng

libpng Copyright: libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18, 2013, are Copyright (c)
2004, 2006-2013.

libpng License: This copy of the libpng notices is provided for your convenience. In case of any discrepancy
between this copy and the notices in the file png.h that is included in the libpng distribution, the latter shall
prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following this sentence.

This code is released under the libpng license.

libpng versions 1.2.6, August 15, 2004, through 1.6.3, July 18, 2013, are Copyright (c) 2004, 2006-2013
Glenn Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-1.2.5
with the following individual added to the list of Contributing Authors, Cosmin Truta

libpng versions 1.0.7, July 1, 2000, through 1.2.5 - October 3, 2002, are Copyright (c) 2000-2002 Glenn
Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-1.0.6 with the
following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux, Eric S. Raymond, Gilles Vollant and with the following additions to the disclaimer:
There is no warranty against interference with your enjoyment of the library or against infringement. There is
no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is
provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with
the user.



libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998, 1999 Glenn
Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-0.96, with the
following individuals added to the list of Contributing Authors: Tom Lane, Glenn Randers-Pehrson, Willem
van Schaik

libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996, 1997 Andreas Dilger
Distributed according to the same disclaimer and license as libpng-0.88, with the following individuals added
to the list of Contributing Authors: John Bowler, Kevin Bracey, Sam Bushell, Magnus Holmgren, Greg
Roelofs, Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995, 1996 Guy Eric Schalnat,
Group 42, Inc.

For the purposes of this copyright and license, "Contributing Authors" is defined as the following set of
individuals: Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all
warranties, expressed or implied, including, without limitation, the warranties of merchantability and of
fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect,
incidental, special, exemplary, or consequential damages, which may result from the use of the PNG
Reference Library, even if advised of the possibility of such damage.

Permission is hereby granted to use, copy, modify, and distribute this source code, or portions hereof, for any
purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.

2. Altered versions must be plainly marked as such and must not be misrepresented as being the original
source.

3. This Copyright notice may not be removed or altered from any source or altered source distribution.

The Contributing Authors and Group 42, Inc. specifically permit, without fee, and encourage the use of this
source code as a component to supporting the PNG file format in commercial products. If you use this
source code in a product, acknowledgment is not required but would be appreciated.

OpenSSL

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the
original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses are
BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact openssl-
core@openssl.org.

OpenSSL License

Copyright (c) 1998-2011 The OpenSSL Project. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.



3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote
products derived from this software without prior written permission. For written permission, please
contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.

6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product
includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).

Original SSLeay License
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
All rights reserved.

This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).

The implementation was written so as to conform with Netscapes SSL. This library is free for commercial and
non-commercial use as long as the following conditions are aheared to. The following conditions apply to all
code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL
documentation included with this distribution is covered by the same copyright terms except that the holder
is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this
package is used in a product, Eric Young should be given attribution as the author of the parts of the library
used. This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.
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3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young (
eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library being
used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson (
tih@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution license \[including the
GNU Public Licence.]

Growl GNTP support:
[The "BSD licence"] Copyright (c) 2009-2010 Yasuhiro Matsumoto
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software
without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Cuda
Cuda Redistributable Software - 1.8. Attachment A



In connection with Section 1.2.1.1 of this Agreement, the following files may be redistributed with software
applications developed by Licensee, including certain variations of these files that have version number or
architecture specific information embedded in the file name - as an example only, for release version 6.0 of
the 64-bit Windows software, the file cudart64_60.dll is redistributable.

Component : CUDA Runtime

Windows : cudart.dll, cudart_static.lib
MacOS : libcudart.dylib, libcudart_static.a
Linux : libcudart.so, libcudart_static.a
Android : libcudart.so, libcudart_static.a

Component : CUDA FFT Library
Windows : cufft.dll

MacOS : libcufft.dylib

Linux : libcufft.so

Android : libcufft.so

Component : CUDA BLAS Library
Windows : cublas.dll

MacOS : libcublas.dylib

Linux : libcublas.so

Android : libcublas.so

Component : CUDA Sparse Matrix Library
Windows : cusparse.dll

MacOs : libcusparse.dylib

Linux : libcusparse.so

Android : libcusparse.so

Component : CUDA Random Number Generation Library
Windows : curand.dll

MacOs : libcurand.dylib

Linux : libcurand.so

Android : libcurand.so

Component : NVIDIA Performance Primitives Library
Windows : nppc.dll, nppi.dll, npps.dll

MacOs : libnppc.dylib, libnppi.dylib, libnpps.dylib
Linux : libnppc.so, libnppi.so, libnpps.so

Android : libnppc.so, libnppi.so, libnpps.so

Component : NVIDIA Optimizing Compiler Library
Windows : nvwm.dll

MacOs : libnvvm.dylib

Linux : libnvvm.so

Component : NVIDIA Common Device Math Functions Library

Windows : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc
MacOs : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc
Linux : libdevice.compute_20.bc, libdevice.compute_30.bc, libdevice.compute_35.bc



Component : CUDA Occupancy Calculation Header Library
All : cuda_occupancy.h

Read more at: http://docs.nvidia.com/cuda/eula/index.html#ixzz30CrknWfU

Warranty The material contained in this document is provided "as is", and is subject to being changed,
without notice, in future editions. Further, to the maximum extent permitted by applicable law, Keysight
disclaims all warranties, either express or implied, with regard to this documentation and any information
contained herein, including but not limited to the implied warranties of merchantability and fitness for a
particular purpose. Keysight shall not be liable for errors or for incidental or consequential damages in
connection with the furnishing, use, or performance of this document or of any information contained herein.
Should Keysight and the user have a separate written agreement with warranty terms covering the material
in this document that conflict with these terms, the warranty terms in the separate agreement shall control.
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Ethernet 802.3-2014 Compliance Test
Bench
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Installing the Ethernet 802.3-2014
Compliance Test Bench

Installing the Ethernet 802.3-2014 Compliance Test
Bench

This section provides information on prerequisites and steps to install the Ethernet 802.3-2014 Compliance Test Bench
(CTB).

Prerequisites
Before using the Ethernet 802.3-2014 CTB, ensure that the following softwares are installed:
® Infiniium Offline (Version 05.50.0015)
® CR4 Compliance App (Version 2.01(2.1%))
® KR4 Compliance App (Version 2.01(2.1%))
* ADS 2016.01

* This is the version that is shown in the splash screen when the app is opened, and also when using the Help->About...

menu from the app.

After installing the Ethernet 802.3-2014 CTB, launch the Infiniium Offline software to ensure the Ethernet 802.3-2014
Test App is available under Analyze > Automated Test Apps.

File Control Setup Display Trigger Measure Math [Analyze | Utilities Demos Help

|| @00mv/ [0.ov  [@] Automated Test Apps N8829A 100GBASE-KR4 Test App

Measurement Analysis (EZIIT)... | NB830A 100GBASE-CR4 Test App
Jitter/Noise (EZJIT Complete)... U7243B USB3 Test App

RTEye/Clock Recovery {(SDA)...
Equalization...

Install Instructions

To install the Ethernet 802.3-2014 CTB:

1. Download the Ethernet802p3.deb package.

2. Select DesignGuide » Add DesignGuide from the ADS Main window.
The Add DesignGuide dialog box is displayed.

3. Click Add Global DesignGuide.
4. Browse and select the Ethernet802p3.deb package.

5. Click Open.
The Ethernet 802.3-2014 Compliance Test Bench will be added.
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. Restart ADS.

. Open a Schematic view and select DesignGuide.

The Ethernet 802.3-2014 Compliance Test Bench will be listed under the DesignGuide menu with the name
'Ethernet 802.3-2014 Compliance Test Bench'.
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Ethernet 802.3-2014 T00GBASE-CR4
Compliance Test Bench Simulation
Setups

Ethernet 802.3 -2014 TO0GBASE-CR4 Compliance
Test Bench Simulation Setups

T00GBASE-CR4 d efines a 4-lane 100 Gbit/s PHY for operation over links consistent with copper twinaxial cables with
lengths up to at least 5m. Signalling used is NRZ.

The Ethernet 802.3-2014 Compliance Test Bench provides a variety of tests, which helps to understand the various
aspects of the Ethernet 802.3-2014 digital standard (CR4, KR4 and KP4). It provides you the ability to create designs
using the included models or your own models. You can refer to the included examples for developing your designs. This

Compliance Test Bench provides the following Models and Examples for CR4:

- Ethernet 802.3bj Compliance Test Bench:1 [

4 Ethernet 802,30
4 CR4
4 Channel Models
Cable Assembly
Host Te Medule Link
Tx Package
Rx Package
4 Compliance Examples
TP2 Transmitter Tests
Transmitter Characteristics
Cable Assembly Characteristics
Receiver Characteristics
> KR4
> KP4
About Ethernet802.3b) Compliance Test Bench
Ethernet802.3b) Compliance Test Bench Documentation

NOTE - The Models used in this design for the host-to-module link, have been downloaded from the IEEE website Public
area - http://www.ieee802.0rg/3/100GCU/public/channel.html

NOTE - Package Models are for educational demonstration only and are not intended for design purposes. Please
download the latest up to date models for your application directly from the vendor’s website. Models in this example

were downloaded from Xilinx Inc. : www.xilinx.com

Models

18
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The following CR4 channel models are available :

® Cable Assembly

Host To Module Link

Tx Package

Rx Package

Examples

The following examples are included in the Ethernet 802.3-2014 Compliance Test Bench for CR4:
® TP2 Transmitter Tests
® Transmitter Characteristics
® (Cable Assembly Characteristics

® Receiver Characteristics

TP2 Transmitter Tests

The following design displays an Ethernet 802.3-2014 CR4 connection from the Transmitter to the Cable Connector(TP2)

where the Transmitter Compliance Testing has to be done:

PMD PMD
sernvice — service
interface fipg] MDI MOl 6';5 interface
| - | — | —— A 1
A1) e\ it st
TP1 TP2) [
| Py v (S BN |
| | l | l |
I I 4x I I
SLi=p= Signal=p= DLi=p=
I > I o I » I
| PMD | SLi=n= | Signal=n= / N | DLi<n> PMD |
transmit " " i
—> ) | Signal shield | [ECENE
| function = — - P == = - — — 1 ~ 7 function |
e S e
| - 4L|II_L _Unkshiel | JJI . |
I I I I
+“——>»r
: TXPCB | : : RX PCEI: :
| L ) Channel ) N |
™ T T L}
I : I I ' I
L PMD Ll Cable assembly Ll PMD O
| Ll L it Lal
| | 1

In this design, a T00GBASE-CR4 link in one direction is displayed. The TO0GBASE-CR4 channel is defined between the
transmitter (TPO) and receiver (TP5) blocks to include the transmitter and receiver differential controlled impedance
printed circuit board insertion loss and the cable assembly insertion loss. For T00GBASE-CR4, there are 4 differential
paths in each direction for a total of 8 pairs, or 16 connections. The circuit below shows 1 transmitting pair. The other 3

pairs introduce crosstalk on to that transmitting pair.

The Transmitter transmits true PRBS9 data using a file 'prbs9_950.txt', at a rate of 25.78125 Gbps.
The signal from a Differential Transmitter flows through the package and host-to-module link. Eye Probes placed in the

circuit capture the waveforms for compliance testing.
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To run the Compliance Test, which requires the Tranmitter to be disabled, disconnect the Tx_Diff

component, short V_DC, deactivate the 'Tx Enabled' block and activate the 'Tx Disabled' block.

For a practical simulation, run using 1000000 bits or more

Xtlk2_Dif CR4_Tx_Package

Xtlkz_DFf1 169 ChannelSim

PraseToTxode=Fixed ChannelSim1

PraseToTk=0.0 NumberOTEits=1000000

Tolerancebode=Auto
»,! S =[] EveDif_Probe EnforcePassivity=yes
i = = =] EyeDiff_Probet Mode=Bit-by-bit

Xilk_Diff CRA_Tx_Parkage _ |

Xtlk2_Dff2 17 q I—_

PhaseToTMode=Fred i = Tx Enabled Tx Disabled

PhaseToTx=0.0 V | !

A 1 SRC1
Vdc=-0.2V MeasEqn =]
1 | Meas!

[ . TPIn=EyeDiff_Probel Waveform

it - =

Dt gﬁg*ﬁfmg - =100 nF RSSO ONFe- ]| Netistinclude List

BitRate=25.78125 Gt} | =

Vhigh=1.6V g =100 nF R=50 Ohm NetlistincludeList

Viow=-08V : | NetlistincludeList1

RiseFallTime=10 psec | | Netlist Type=ads

Mode=Bit File I | NetlistName[ 1]="TP2 net"

ExcludeLoad=no I |

EQMode=Specy FIR] | | N

AR =
X - | VAR1
- I 5 Y | WareformPath="wavefoms"

Xtlk2_Dift CR4_T_Package Fzf0 Ohm  CR4 Host THSBRORTL Ik

Xtlk2_Dff3 1_66 R=50 Ohm |_2 R=50 Ohm

PhaseToTxode=Fixed

PraseToTk=0.0

DB cizar- Tre Vissel Ueed 7 T GEH T IR MOZHOTO0UR I, T2 320 QDTSSR M D 1S5S WED:hE PLAR 163 NI WL 8502 01 1OOSCURLS Rz el

WARNNG: Patta g 10108 s pums e
B as R M Lt T B TS e L

1B s ors o caton demanstaon o v ot
IS SIaMpe WS & 00N IS9E0 Tom X B WWW oM

S e S hee

The two lines of the differential pair should carry signals between the same voltage levels but having opposite state. The

ADS Tx component creates a differential pair where the two lines carry signals from 0 to X volts and 0 to -X volts, instead

of the required 0 to X volts for both lines. To overcome this, a dc voltage of -0.2V is applied to the differential eye probe

to move the 'n' signal in the same voltage level as the 'p' signal.

The waveforms generated at TP2 are saved in the data/waveforms directory with the names TP2p.h5 and TP2n.h5.

Transmitter Characteristics

The following design shows the S-Parameter simulation required for the CR4 Transmitter Compliance. The results have

been compared with the corresponding Masks.

|@R | sParaverERs |- i L
- 5_-Param Tem .
SR .. | Tem2,
O hnt
. Start=0.01 GHz, =1 T ) oy _Num=2 )
Stop=18 GHz i {5 Z=50 Ohm
" Step=0.01 GHz . - ReS0Ohm | - f#£0 Ohm i e
2°cl SARZRT i =
1
| [ 5 =
i v e Term -
1
2 A i Term 4
. b [ Hum=4 .
= ™ ] = G
] T 250 Ohm
=3 - Ohnr =
Lo
Lol 7, Ohnr i
. hor fi
b ]
[ | Rzp0 O

R730 Chm
R=50 Ohm

]

. Digciamer - The Modkls used In 3115 gesign for e Nostip-maogke Ik, Rave Deen downloaged fom e

VARMING: Pacicage M el are for 20U miDnal Gam OnSTAToN Only 200 ane Not IMende for 0 ASQN DUDOSES
. Plmass download, She lsiestup & dafe modsals for your snplication drecth fom Sie vendor's webste Modek
i Sis: =g Die wiere o own b aced & om 3O Inc. - w e XIBCom

sl Pupllc area - FEpw L lees SOZ00 S

GR4_Host: TR Sf0kmLink

R=50 Ohnr

U punlicicharmeL |

The following parameters are plotted in the results, along with their masks:

¢ Differential Output Return Loss

® Common-mode to differential mode output return loss
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¢ Common-mode to common-mode output return loss

ﬂSDDE#D.E-'[E{” 252 AFS4214544)

Bl otputRetumLoss= ififreq<8s8) hen-(8.5-0.37~(freq"1s-0)) slse-[4. 757 4log 10ifreg™1s-0/14))
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w 40
8.
=H
=
=@
- 0
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5 =
=304
= T T T T T T T T 1T 1T 71 T T T
) 4 ] 10 1 14 18 12 I
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M S0C22-05%S(2.21+5(2.4)-H(4.2-5(4.4))

mC.:}rrrnTGDiffI‘u‘erEDLrtputF{EturnL:E-s=i‘f{1"rE:|<:1ZSG'EE:I then- (22202578 freg™16-8) else-(15-(8/ 2578 Feg™1a-)
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Cable Assembly Characteristics

The following design shows the S-Parameter simulation of a CR4 Cable Assembly. The results have been compared with

the corresponding Cable Assembly Masks:
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.|@|.543ARAMETERS | .

5_Param
‘8Pt
- Start=0.01 GHz
- Stop=19GHz -
. Step=0.01 GHz.

Disclaimer- The Mode psed In ME design for Mg cable, have been downloadad fom e

. el

o Bs00m )}
~ R¥R00hM CR4 Cable
. Res00mm L0

Chm

Rzl

ReB0@nm:2;

_ R=500hm

EEE wepshe Public 313 - g www lee2502 03] 00GCUpUD ke channe Ltml

The following parameters are plotted in the results, along with their masks:

® Maximum insertion loss at 12.8906 GHz

® Minimum insertion loss at 12.8906 GHz

® Minimum return loss at 12.8906 GHz

® Differential to common-mode return loss

® Differential to common-mode conversion loss

® Common-mode to common-mode return loss

Receiver Characteristics

S0 T i e ron9S i DR AN A1 5505 a0 3R A 12 5505 83 P20 4TS

e
=

e ]

T

Hose_ Ranumoasm?

EARREAERE ISR REAE)

Temn °
Term2
Num=2 -

Z=500hm .

Tem .
Temd
Num=4

Z=50 0hm ~

The following design shows the S-Parameter simulation required for the CR4 Receiver Compliance. The results have been

compared with the corresponding Masks.
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| &5 | S-PARAMETERS l

S_Param

SP1
Start=0.01 GHz
Stop=19 GHz
Step=0.01 GHz
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The following parameters are plotted in the results, along with their masks:

® Differential input return loss

® Differential to common-mode input return loss
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References

® |EEE Std 802.3bj™-2014 - IEEE Standard for Ethernet, Amendment 2: Physical Layer Specifications and

Management Parameters for 100 Gb/s Operation Over Backplanes and Copper Cables
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Running T00GBASE-CR4 Compliance
Tests on Infinilum Offline

Running T00GBASE-CR4 Compliance Tests on
Infinilum Offline

Using the Keysight Infiniium Offline software you can run the compliance test on these waveforms. In the Ethernet 802.3-
2014 100GBASE-CR4 Compliance Test Bench Simulation Setups section, the Channel Simulation example generated

signal waveforms in .h5 format.

For the test that requires the transmitter to be disabled, use the waveforms generated after making

the necessary changes as described in the design.

The waveforms TPZ2p.h5 and TP2n.h5 are used in this tutorial.

Ensure that the waveforms are generated with number of bits simulated in the Channel Simulation

Controller equal to or more than 1000000.

To run the Compliance tests:

1. Click Analyze > Automated Test Apps > N8830A 100GBASE-CR4 Test App from the Infiniium Offline software to
open the CR4 application.

=
File Control Setup Display Trigger Measure Math |[Analyze |Utilities Demos Help

Offline

Mask Test...

Autormated Test Apps N8829A 100GBASE-KR4 Test App
Measurement Analysis (EZJIT)... | N8830A 100GBASE-CR4 Test App |
Jitter/Noise (EZJIT Complete)... U7243B USB3 Test App

RTEye/Clock Recovery {SDA)...
Equalization...

-500 ns -400 ns

|@ [100ns/ (0.0
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2. In the Setup tab, click Saved Waveform Setup.
100GBASE-CR4 App Test -- 100GBASE-CR4 App Devicel ===

File View Tools Help

O | & pE I |

SetUp | Select Tests | Configure | Connect | Run Tests | Automation | Results | HemlReport |
Test Environment Setup

SetUp

—Device Under Test {DUT)

—Measurement Ophon———— Multi-Lane Opion——————
Select Tests % 100GBASE-CR4 " Switch Matrix

" Four Diff Probe Pairs

& Single Lane

—Scope Channel Pair———

(% Real Edge
" Channels 1and 3

Configure

”Sel ect Lane Number——

" Channels 2 and 4 Lane0 |
Canneck
— Test Report Comment= (Optional)
Device ldentifier: User Description:
Run Tests |{SELECT OR TYFE) -] |{SELECT OR TYFE) -]
Comments:
| A
1
InfiniiSim Setup Set Channel skew | 5“""’"'5"’"'3‘"’*""“

[No Device Connected PNA | Comnect PNAENA |

MNOTE: If Rezl Edge Channels are not used, measwrements will be bandwidth limisd

| 0Tests  |[Follow instructions to describe your test environment Connection: UMKNOWMN y
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3. Click Browse and select the TP2p.h5 and TP2n.h5 waveform files for the DUT+ and DUT- fields respectively. Click

Done.

a5 frrmOfflineSetup o= =]

DT+ waveform for General Measurements:

|'~'an"-1:|efauh'l 5_01%Ethemet_wrk \data waveforms  TP2p h5 Browse

DUT- waveform for General Measurements:
|'~'an"-1:|efauh'l & 01\Ethemet_wrd \data'waveforms  TP2n h5 Browse

Done
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4. Click the Select Tests tab and select the tests, as shown in the following figure:
100GBASE-CR4 App Test -- 100GBASE-CR4 App Device 1 * (===

File View Tools Help

D@ H| @701 |2®e

'setlp SelectTests | Configure | Connect | Run Tests | Automation | Results | Heml Report |
=-0o

2] © Main Voltage Measurements (pattern: PRESS)

[J© Differential Peak to Peak Output Voltage Test with TX disabled
) DC Commen Mode Output Voltage Test

) AC Commen Mode Output Voltage Test

O Differential Peak to Peak Output Voltage Test

E-[#] © Jitter and Signaling Rate Measurements (pattern: PRESS)

O Signaling Rate

© Even-Odd Jitter

© Bounded Uncorrelated Jitter

O Total Uncorrelated Jitter

E-[#] © Output Waveform Measurements {pattern: PRESS)

) Steady-State Voltage Vf

© Linear Fit Pulse Peak

) Signal-to-noise-and-distortion ratio

SetUp

Select Tests

Configure

Run Tests

(Click a test's name to see description)

Limit Set: IEEE 802.3 100GBASE-CR4 Test Limit




Ethernet 802.3-2014 Compliance Test Bench

5. Click the Connect tab and select the following:
a. Check I have completed the instructions.
b. Click Run Tests.

100GBASE-CR4 App Test -- 100GBASE-CR4 App Device1 ™ o= ][=]

File View Tools Help
Ow W "»Wre |

SetUp | Select Tests | Configure Connect | Run Tests | Automation | Resuits | Hml Report |

SetUp

10 tests will -
be run. Please pay attention to the scope connection

2 different

Select Tests gtzii:d“" » This test can only be run with dual single-ended connections and

be used. waveforms
:’;:f?st s Connect the scope to the DUT Signals as follows:
Config shown,
e No Connection. Running Offline Waveforms.
Followthese
instructions
to start
testing

B

Run Tests | [ sSuppress all connection prompts

| 10 Tests |Fo||ow instructions to connect the DUT, then press [Start] |Connection: Common Mode Test Connection For MultiLane Yy

6. Once the tests are completed, you can view the test results under the Results tab.
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100GBASE-CR4 App Test -- 100GBASE-CR4 App Devicel *
File View Tools Help

==

=]

D M| @[ X

Task Flow _| 'setup | Select Tests | Configure | Connect | Run Tests | Automation Resuits | Himl Report |

SetUp Test Name | Actual Val
-/ DC Comman Mode Output Voltage Test 87.93mV 4.6%
-/ AC Common Mode Qutput Voltage Test 3.70 mv 87.7%
-/ Differential Peak to Peak Output Voltage Test 1,133V 5.6%
Select Tests -/ signaling Rate 25781198918 Ghps  49.0%
\/ Even-Odd Jitter 22.6mlI 35.4%
-/ Bounded Uncorrelated Jitter 2.6 mUl 97.4%
-/ Total Uncorrelated Jitter 25.5mlI 85.8%
Configure -/ Steady-State Voltage VF 564 my 13.8%
-/ Linear Fit Pulse Peak 380 mv 49.6%
-/ signal-to-noise-and-distortion ratio 34.341dB 32.1%

| Margin I Pass Limits

0.00000 V <= VALUE <= 1,90000 V

VALUE <= 30.00 mV

VALUE <= 1200V

25.778671875 Gbps <= VALUE <= 25.733828125 Gbps
VALUE <= 35.0 mUI

VALUE <= 100.0 mUI

VALUE <= 180.0 mUI

340mV <= VALUE <= 600 mV

VALUE >= LinearMin V

VALUE »= 26,000 d&

<

Details: Signal-to-noise-and-distortion ratio

Actual Valu 34.341 dB
R
Number UI Tested 1e6

Lane Number Laned

f Trial 1 |
Parameter | Value |
Pass Limits == 26.000 dB

Parameter Tested Signal-to-neise-and-distortion ratio

| 10 Tests ‘10 results shown. [Himl Report] tab shows details |Connection: PRESY Connection |

You can also view the HTML report under the HTML Report tab.

100GEASE-CR4 App Test -- 100GBASE-CR4 App Devicel *
File View Tools Help

DEdl wWrir | RE

SetUp
KEYSIGHT

TECHMOLOGIES

Configure

Summary of Results

Passed| 10
Total| 10

Device
SwitchOption
[BhanPair T Real Edge
Speed Grade T 100GBAsE-CRe

Test Session Details
linfiniium Mode Number 1123004
linfiniium Serial Number 1o Sere
Application SW Version 201
Debughode Used 110
|Compliance Limits (official) [EEE £02.3 100GBASE-CR4 Test Limit
[LastTestpate | |[2015-07-21 14:17:45 UTC +05:30

100GBASE-CR4 App Test Report

Overall Result:

Description

Task Flow | 'SetUp | Select Tests | Configure | Connect | Run Tests | Automation | Results ~Html Report

Single Lane

| 10 Tests |\|"|ew,|fSave,-'Pn'nt detailed HTML results. Connection: PRESS Connection
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If you open the Select Tests tab before loading your waveforms, you will see tests which are not
listed in the screenshot in Step 4 above. These tests are in the application but not supported
currently. They will be supported in a future release of this Compliance Test Bench and 1T00GBASE-
CR4 application.

References
® |EEE Std 802.3bj™-2014 - IEEE Standard for Ethernet, Amendment 2: Physical Layer Specifications and

Management Parameters for 100 Gb/s Operation Over Backplanes and Copper Cables
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Ethernet 802.3-2014 T00GBASE-KR4
Compliance Test Bench Simulation
Setups

Ethernet 802.3 -2014 TO0OGBASE-KR4 Compliance
Test Bench Simulation Setups

T00GBASE-KR4 d efines a 4-lane 100 Gbit/s backplane PHY for operation over links consistent with copper traces on
“improved FR-4” with lengths up to at least Tm . Signalling used is NRZ.

The Ethernet 802.3-2014 Compliance Test Bench provides a variety of tests, which helps to understand the various
aspects of the Ethernet 802.3-2014 digital standard (CR4, KR4 and KP4). It provides you the ability to create designs
using the included models or your own models. You can refer to the included examples when developing the designs.

This Compliance Test Bench provides the following Models and Examples for KR4:

T Ethernet 802.3bj Compliance Test Bench:l =
4 Ethernet 802.3b
> CRd
4 KR4
4 Channel Models
Card Trace
Channel
Tx Package
Fx Package

4 Compliance Examples
TPOa Transmitter Tests
Transmitter Characteristics
Channel Characteristics
Receiver Characteristics
> KP4
About Ethernet802.3b) Compliance Test Bench
Etherneti02.3b) Compliance Test Bench Documentation

NOTE - The Models used in this design for the host-to-module link, have been downloaded from the IEEE website Public
area - http://www.ieee802.0rg/3/100GCU/public/channel.html

NOTE - Package Models are for educational demonstration only and are not intended for design purposes. Please
download the latest up to date models for your application directly from the vendor’s website. Models in this example

were downloaded from Xilinx Inc. : www.xilinx.com

Models

The following KR4 channel models are supported:

® Card Trace
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® Channel
® Tx Package

® Rx Package

Examples

The following examples are included in the Ethernet 802.3-2014 Compliance Test Bench for KR4:
® TPOa Transmitter Tests
® Transmitter Characteristics
® Channel Characteristics

® Receiver Characteristics

TPOa Transmitter Tests

The following design displays an Ethernet 802.3-2014 KR4 connection from the Transmitter to the Card Traces(TPOa)

where the Transmitter Compliance testing is done.

PMD PMD
service —. service
interface I\PEII I':F-PS interface
I pvD T Channel :r: PMD |
I 'l ! I
| | | |
PMD | [ PMD
—I—p transmit I I | receive —I—D-
| function function |
I | ! I
I I
Device I | Device
£ | Mated | Package
I:':Ir | connectar AC-coupling |
G o V
— SLi=p=
/7 — > (—» 1
/ SLi=n= | i\ |
Package-to » ) — ;
board-interface

One direction for one lane of a T00GBASE-KR4 link is shown in Figure above. The 1T00GBASE-KR4 channel is defined
between the transmitter (TP0) and receiver (TP5) blocks.

For T00GBASE-KR4, there are 4 differential lanes in each direction for a total of 8 pairs, or 16 connections. The circuit
below shows 1 transmitting lane. The other 3 lanes are not shown as the crosstalk effects are negligible.

The Transmitter transmits true PRBS9 data using a file 'prbs9_950.txt', at a rate of 25.78125 Gbps.

The signal from a Differential Transmitter flows through the package and card traces. Eye Probes placed in the circuit at

TPOa capture the waveforms for compliance testing.
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GE@ .KFIE‘*.

Device Device | T
i package | |
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' |
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SLi=p= |

/ SLi=n=

Package-to- PJ
board interface |

A

Transmitter test fixture

To run the Compliance Test which requires the Tranmitter to be disabled, disconnect the Tx_Diff

component, short V_DC, deactivate the 'Tx Enabled' block and activate the 'Tx Disabled' block.

| 'TxEnabled = @ T Tx Disabled

"

0a_p=Eye_Probet Wawefor

KRA_TP0a_p= ™
KR4_TPla_n=Eye[i# Probet Wawebrm

B s | o T

AR
WasehrmFath= matorms"

The two lines of the differential pair should carry signals between the same voltage levels but having opposite state. The

ADS Tx component creates a differential pair where the two lines carry signals from 0 to X volts and 0 to -X volts, instead
of the required 0 to X volts for both lines.

To overcome this, a dc voltage of -0.2V is applied to the differential eye probe to move the 'n' signal in the same voltage

level as the 'p' signal.

The waveforms generated at TPOa are saved in the data/waveforms directory with the names KR4_TPOa_p.h5 and

KR4_TPOa_n.h5.

Transmitter Characteristics

The following design shows the S-Parameter simulation required for the KR4 Transmitter Compliance. The results have

been compared with the corresponding Masks.
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The following parameters are plotted in the results, along with their masks:
¢ Differential Output Return Loss

® Common-mode output return loss
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Channel Characteristics

The following design shows the S-Parameter simulation of a KR4 Channel. The results have been compared with the

corresponding Channel Masks.
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The following parameters that are plotted in the results, along with their masks:
® Insertion Loss
® Return Loss
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Receiver Characteristics
The following design shows the S-Parameter simulation required for the KR4 Receiver Compliance. The results have been

compared with the corresponding Masks.
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The following parameters that are plotted in the results, along with their masks:

® Differential input return loss

¢ Differential to common-mode input return loss
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References

® |EEE Std 802.3bj™-2014 - IEEE Standard for Ethernet, Amendment 2: Physical Layer Specifications and

Management Parameters for 100 Gb/s Operation Over Backplanes and Copper Cables
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Running T00GBASE-KR4 Compliance
Tests on Infinilum Offline

Running 100GBASE-KR4 Compliance Tests on
Infinilum Offline

In the Ethernet 802.3-2014 100GBASE-KR4 Compliance Test Bench Simulation Setups section, the Channel Simulation
example generates signal waveforms in .h5 format. Using the Keysight Infiniium Offline software you can run the

compliance test on these waveforms.

The waveforms KR4_TPOa_p.h5 and KR4_TPOa_n.h5 are used in this tutorial. For the test that requires the transmitter to

be disabled, use the waveforms generated after making the necessary changes as described in the design.

Ensure that the waveforms are generated with number of bits simulated in the Channel Simulation

Controller equal to or more than 1000000

To run the Compliance tests:

1. Click Analyze > Automated Test Apps > N8829A 100GBASE-KR4 Test App from the Infiniium Offline software to
open the KR4 application.

=
File Control Setup Display r Measure Math |Analyze | Utilities Demos Help

Histag
Mask Test...
(@oov Juov |@O Automated Test Apps NBB29A 100GBASE-KRA Test App

Measurement Analysis (EZIIT)... | N8830A 100GBASE-CR4 Test App
Jitter/Noise (EZIIT Complete)... U7243B USB3 Test App

RTEye/Clock Recovery {SDA)...
Equalization...

=
E]
[
=
]
I
[

<
@
=]
g
=
o
&
&

S00ns  -400ns 200 ns
|@ [100ns/ (0.0
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2. Click Saved Waveform Setup in the Set Up tab.

100GBASE-KR4 App Test -- 100GBASE-KR4 App Device 1 *

File View Tools Help

= = N

Task Flow _

SetUp

Test Environment Setup

SetUp | select Tests | Configure | Connect | Run Tests | Automaton | Resuits | Himl Report |

—Device Under Test (DUT)

—Measurement Opion————
* 100GBASE-KR4

Scope Channel Pair

Configure

@ Resl Edge
 Channels 1and 3
" Channels 2and 4

Conneck

Multi-Lane Opion—————————
" Switch Matrix
" Four Diff Probe Pairs

% Single Lane

"Sel ectLane Number————

I Lanel vl

—TestReport Ci iz (Optional)
Device |dentifier: User Description:
Run Tests |{SELECTOR TYPE) ~| |{SELECT OR TYPE) |
Comments:
| :
InfiniiSim Setup Set Channel skew | SR

No Device Connected

FNA

| __ Connect PNAENA |

NOTE: If Real Edge Channels are not used, messurements will be bandwidth limisd.

| 0Tests  Folow instructions to describe your test environment

Connection: UNKNOWN
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3. Click Browse and select the KR4_TP0Oa_p.h5 and KR4_TP0a_n.h5 waveform files for the DUT+ and DUT- fields

respectively.

a5 frmOfflineSetup o | = &3]

DT+ waveform for General Measurements:

|auft'| 5_01'\Ethemet_wr data‘waveforms'KR4_TP0a_p h5 Browse

DUT- wawveform for General Measurements:
lault 15_071\Ethemet_wrk'data‘waveforms\KR4_TPla_n h5 Browse

Done

4, Click Done.

5. Click the Select Tests tab.
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6. Select the tests, as shown in the following figure:

100GBASE-KR4 App Test -- 100GBASE-KR4 App Devicel *
File View Tools Help

(e [@=]

D H| 23 |2 %0

Task Flow _| 'setlp SelectTests | Configure | Connect | Run Tests | Automation | Resuits | Hemi Report |

SetUp B[] 100GBASE-+R4 Tests

Select Tests

----- ) Signaling Rate

----- O Even-Odd Jitter

) Bounded Uncorrelated Jitter
----- O Total Uncorrelated Jitter

Configure

----- ) Steady-State Voltage Vf
----- O Linear Fit Pulse Peak

Run Tests

E-[]© Main Voltage Measurements (pattern: PRESS)

----- [] < rifferential Peak to Peak Output Voltage Test with TX disabled
----- ' DC Common Mode Output Voltage Test

O AC Common Mode Output Voltage Test

O Differential Peak to Peak Output Voltage Test

- [w] O Jitter and Signaling Rate Measurements {pattern: PRES3)

B[] © Output Waveform Measurements (pattern: PRESS)

----- O Signal-to-noise-and-distortion ratio

(Click a test's name to see description)

Limit Set: IEEE 802.3 100GEASE-KR4 Test Limit

7. Click the Connect tab.
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8. Select | have completed the instructions.

100GBASE-KR4 App Test -- 100GBASE-KR4 App Devicel ™
File View Tools Help

D& ||

DB GE |

Task Flow _

SetUp

Configure

Run Tests

SetUp | Select Tests | Conficure  Connect | Run Tests | Automation | Resuits | Heml Report |

10 tests will

be run. Please pay attention to the scope connection

2 different

msdvill o This test can only be run with dual single-ended connections and waveforms
be used. » Connect the scope to the DUT Signals as follows:

The first

:m:.; No Connection. Running Offline Waveforms.

Followithese
instructions
to start
testing

Run Tests | [ suppress all connection prompts

| 10 Tests |Fol|ow instructions to connect the DUT, then press [Start] |Connection: Commen Mode Test Connection For MultiLane

9. Click Run Tests.

10. Click the Results tab. The test results are displayed, as shown in the following figure:

100GBASE-KR4 App Test -- 100GBASE-KRA App Device 1 =
File View Tools Help

==

0w ||

DEE | XK 1%

Task Flow _

SetUp

Run Tests

SetUp | Select Tests | Configure | Connect | Run Tests | Automation Results | Hem Report |

Test Mame | Actual val | Margin | Fass Limits

// DC Common Mode Output Voltage Test 95.72mV 5.1%  0.00000V <=VALLE <= 190000V

/ AC Common Mode Output Voltage Test 1.24mV 89.7% VALUE <= 12,00 mV

/ Differential Peak to Peak Qutput Voltage Test 1,131V 5.8%  VALUE <= 1200V

/ Signaling Rate 25.781185743Gbps  48.8%  25.778671875 Gbps <= VALLE <= 25.78382812!
/ Even-Odd Jitter 19.2 mUl 45.1% VALUE <= 35.0 mUI

/ Bounded Uncarrelated Jitter 3.8mlI 96.2%  VALUE <= 100.0 mUI

/ Total Uncorrelated Jitter 26.7 mUL 85.2% VALUE <= 180.0 mUI

/ Steady-State Voltage Vf 556 mvV 22.0% 400 mV <= VALUE <= 600 mV

/ Linear Fit Pulse Peak 395 mv 0.0%  VALUE == LinearMin V

/ Signal-to-noise-and-distortion ratio 32.809 dB 21.5% VALUE »>= 27.000 dB

« m

Details: Signal-to-noise-and-distortion ratio

/ Trial 1 |

Parameter | Value |
Pass Limits == 27.000 dB

Parameter Tested Signal-to-noise-and-distortion ratio

Actual Value 32,809 dB
R 5
Number UI Tested 1e6
Lane Number Lanel

| 10 Tests |10 results shown. [Himl Report] tab shows details |Connection: PRBSY Connection |

You can also view the HTML report under the HTML Report tab.
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100GBASE-KR4 App Test -- 100GBASE-KR4 App Devicel ™ [ =@ =]
File View Tools Help
DEd| WiEr|R&E
‘set UpI Select Tests | Configure | Connactl Run Tests | Automation | Results Html Report
setUp =
KEYSIGHT
TECHNOLOGIES
Select Tests
- 100GBASE-KR4 App Test Report
Overall Result:
[ TestConfigurationDetals
Device Description
B [ChanPair T Real Eage
[Spe=d Grade! I [100GBASEKR4
Test Session Details
linfiniiarm Wodei Namber | vas00
linfiniium Serial Number | o Seria
Applcation St Vorsion 2.
[Debug Mode Used [1is
|Compliance Limits (official) |EEE 302 3 100GBASE-KR4 Test Limt
[CastTestbate 7 [2015-07-21 15:16:52 UTC +05:30
Summary of Results
Test Statistics.
Failed| 0
Passed| 10
Total| 10 -

| ¥ 10 Tests

|\|"|ew,fSave,|'Print detailed HTML results.

Connection: PRESS Connection

If you open the Select Tests tab before loading your waveforms, you will see tests that are not

listed in the screenshot in Step 4 above. These tests are in the application but not supported

currently. They will be supported in a future release of this Compliance Test Bench and
100GBASE-KR4 application.

References
© |EEE Std 802.3bj™-2014 - IEEE Standard for Ethernet, Amendment 2: Physical Layer Specifications and

Management Parameters for 100 Gb/s Operation Over Backplanes and Copper Cables
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Ethernet 802.3-2014 TO0GBASE-KP4
Compliance Test Bench Simulation
Setups

Ethernet 802.3-2014 T00GBASE-KP4 Compliance
Test Bench Simulation Setups

T00GBASE -KP4 d efines a 4-lane 100 Gbit/s backplane PHY for operation over links consistent with copper traces on
“improved FR-4” with lengths up to at least Tm . Signalling used is PAM4.

The Ethernet 802.3-2014 Compliance Test Bench provides a variety of tests, which helps to understand the various
aspects of the Ethernet 802.3-2014 digital standard (CR4, KR4 and KP4). It provides you the ability to create designs
using the included models or your own models. You can refer to the included examples when developing the designs.

This Compliance Test Bench provides the following Models and Examples for KR4:

Tl Ethernet 802.3-2014 Compliance Test Bench:l =

4 Ethernet 802.3-2014
> 100GBASE-CR4
» 100GBASE-KR4
4 |100GBASE-KP4
4 Channel Models
Tx BGA Package
Blind_Via model_Commeon_&ntipad
Blind_Via model_Separate_Antipad
Standard_Via model_Separate_Antipad
Transmission_Line_CoupledTrace
Transmissien_Line_SingleTrace
Rx BGA Package
4 Simulation Test Examples
4 Channel Operating Margin (COM) Analysis
FEXT Analysis
MEXT Analysis
THRU_Channel Analysis
Channel Simulation
Channel Crosstalk Analysis
EthernetB02.3-2014 Compliance Test Bench Documentation
About Ethernet802.3-2014 Compliance Test Bench

i | 1] [ P

NOTE -
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1. Package Models are for educational demonstration only and are not intended for design purposes. Please
download the latest up to date models for your application directly from the vendor’s website. Models in this

example were downloaded from Xilinx Inc. : www.xilinx.com

2. This design guide includes features which are supported after ADS 2016.01 version.

Models

The following KP4 channel models are supported:
® Tx Package
® Rx Package
¢ Connector
® Via models

® Transmission Line Models

Examples
The following examples are included in the Ethernet 802.3-2014 Compliance Test Bench for KR4:

® Channel Crosstalk Analysis
® Channel Operating Margin (COM) Analysis

® Channel Simulation

C hannel Crosstalk Analysis

Enable or Disable Crosstalk components, "Xtalk TX AMI & Xtalk RX AMI", to see the interference of noise on Eye Diagram.

Eye_Probe1.Density
Waveform
°
T

0 20 40 60 80 100 120 140 160

0ogl

5981 —
08k —
§48L—
088l —
5881 —
068l —
5681 —
0086l —
§06L—
018l —
G168l —
0zZ6lL

time, psec

time, nsec
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C hannel Operating Margin (COM) Analysis

The following design shows the S-Parameter generating model required to run Channel Operating Margin (COM) Analysis

for the KP4. In order to perform COM analysis, the user need to generate THRU channel, FEXT and NEXT models fro the

channel. Goto respective designs to generate the required models.

THRU Channel Analysis:

This design extracts the following files in data folder of workspace.

1. config_com_ieee8023_93a=100GBASE-KP4.xls
2. config_com_ieee8023_93a_doc.pdf

3. com_ieee8023 93a.m

Run this design to generate "COM_Thru" 4 port S-parameter model at data folder of workspace.

FEXT Analysis:

This design extracts the following files in data folder of workspace.

1. config_com_ieee8023_93a=100GBASE-KP4.xls
2. config_com_ieee8023_93a_doc.pdf

3. com_ieee8023 93a.m

Run this design to generate "COM_FEXT" 4 port S-parameter model at data folder of workspace.

NEXT Analysis:

This design extracts the following files in data folder of workspace.

1. config_com_ieee8023_93a=100GBASE-KP4.xls
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2. config_com_ieee8023_93a_doc.pdf

3. com_ieee8023_93a.m

Run this design to generate "COM_NEXT" 4 port S-parameter model at data folder of workspace.

Matlab for Channel Operating Margin (COM) Analysis:

» Open the Matlab software and load the code "com_ieee8023_93a.m"

4\ MATLAB R2014

PUBLISH

ch g g @ mset 5, fx il v <o P E mmsen &

-|compare v Comment & 4l llGoTo ~

New|

[ 4 open =
— . " 1

BTG & | ] || Scarch Analysis update 2

+q

Curd ~ Organize »  New folder ©® | pdate\com,ieect023 930.m

“ Neme ’ Date modified Type Size

com_ieeeB023_ 93a.m 8/25/20158:13PM  MATLAB Code foete

o

Command Window

(@ New to MATLAB? Watch this Video, see Examples, or read Getting Started.

® Now edit the contents in "config_com_ieee8023_93a=100GBASE-KP4.xls" file and save them as per the design

requirement.
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- config_com_ieeeB023 93a=100GBASE-KP4.xls [Compatibility Mode] - Microsoft Excel

Home | Inset  Pagelayout  Fornulas  Data  Review  View

=4 cut ) [ ra—

4 Calibri B Y General - ﬁi Normal 2 Normal Bad Good Neutral
Ba copy -
Paste Fromatrsmer| B L U E - =55 EMergeaCenter- | § - % Conditional Format |:| @ Followed Hy... Hyperlink
M ormat Painter Formatting - as Table =
Clipboard Font Alignment Number Stytes
B3 hd £ | =12.5*87/80
A 5 c D £ G G H 7 3 T 0]

1 Table 93A-1 parameters 1/0 control Table 93A-2 parameters

2 Parameter Sefting Units Information DIAGNOSTICS 1 Parameter Setting. Units
3 359375 Gad DISPLAY_WINDOW 1 package_tl_tau £141E03 ns
4 f_min 0.05 GHz Display frequency domain 1 package_tl_gamma0_al a2 [[01734e-31455e-4]

5 Deitat 001 Griz CSV_REPORT 1 package 2_c 72 Ohm
6 cd [25e-425e-4] nF [TXRX] SAVE_FIGURE_to_CSV [i]

7 2 pseiea ) feest cases to runl RESULT_DIR \eest_resuits_0o8 Table 92-12 parameters

8 zp (M) 12 34 mm test cases] SAVE_FIGURES o logical Parameter Setting.

] z_p (NEXT) 1212 mm test cases] Port Order [1324] board_tl_tau 6.101E-03 ns
10 =_p (FEXT) 123 mm test cases) Receiver testing board_tl_gamma0_s1_a) _|[04114e-42587e4]

1 p RN TE m testcases R¥_CALIERATION 0 board 2_c 1098 Ohm
i) p [18e4 18] oF R Sigma B8N step S00E0S = bp (7] 151 m
13 R0 £l Ohm TDEAL_T¥_TERM o Togical =_bp (NEXT] 7 m
1 R_d [5555] Ohm TTXRR] T B00EDS ns = bp (FEXT) 7 m
15 o o7 ED = bp (RX) = m
15 <0} 062 min options.

7 o) [-0180020] i INC_PACKAGE M 1 Togical

18 ) [0380020) TDEAL_RX_TERM o

19 .0C 1z10] @ INCLUDE_CTiE 1

20 iz 33984375 Griz INCLUDE_TX_RX FITER 1

2 el 33984375 Griz

2 p2 1359975 Griz

) Av 04 v

u Ate 04 v

25 Ane 05 v

2 L 4

7 ] 2

) [ 15 ur

29 b_max(1) 1

30 b_max(2.N_b) 02

31 sigma_RJ 0.005 ur

2 A DD 0.025 ur

33 et 0 520608 V2/Grz

N ShR_TX 51 @

55 R 092

3 DER 0 300604

37 ‘Operational control

38 _COM Pass thresnoia_| 3 @ | I

39 incugepcs | 0 [Togicar | ]
)
a
2
[
“
5
%
]
s

® Click Run in the Matlab software to Start simulation

4\ MATLAB R2014a2

W o wops e
T =] [ Find Files Insert
o= £

P ot~
New Open save - ™ &= L
Y Y G Indent -] {Fnd v

€ (35 » G » Uses » rameshpl » Documents » MATLAB »
CunentFoldes
Name | com_ieee8023_93a.m +

M\Analysis_update\cor

@ . testresuts o4 @ Thisfile can be published to  formatted document,For more nformation, see the publishing video o help x

function results=com ieee8023_83a(config_file, num fext, num next, varargin) =

+ enentas of Znnex

® Click Enter to load the configuration file " "config_com_ieee8023_93a=100GBASE-KP4.xls
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4\ MATLAB R2014a

PUBLISH VEW

¢5 g [ @ mme;[xE,:v $a > & S &

-l comoare = _Comment ' SiGeTo v

"2 4 wpur cons e s =
- ~ - « wrk » data » v [ 42 | Search data |
| GO [ “
G| Orgomie = Newfolder = - 0 O |lpseconisonsen © x| Worsp
a Name ’ Date Type Size Name
= x
next, varargin) ~a

] config_com_ieee8023_93a=100GBASE-KP.

dia i »

File pame: v | Cxis) -

Command Window ®

Your MATLAB license will expire in 47 days.
Please contact your system administrator or
MathWorks to renew this license.

>> com_ieee2023 832
COM tool for P802.3bj Draft 3.2/P802.3bm Draft 2.2 (SRevision: 1.54 §)

This is not an official IEEE document.

Annex 934 is normative for some implementations. This code is a sample implementation of Annex 93A and is not nomative.
Enter config XLS file or return will just pop a window to ask for the XLS file]:

=

® Enter the number of channel of created for FEXT and NEXT analysis. In this case, we have created for 1 channel for
FEXT and 1 channel for NEXT channel.Click enter to load the touchstone models from data folder of workspace.
This file will be generated from ADS channel simulation: COM_Thru.s4p , COM_FEXT.s4p and COM_NEXT.s4p one
by one a Matlab prompts.

4\ MATLABR20142

PUBLISH VEW

— - | i Insert || Fil = = &
o g @ et & fr ] - [ B B paesess &
\L/Compare v Comment % gz £J i GoTo v
New Open Save % Sresiponts  Run  Runand || Advance  Runand
T T T em indent ] 6 i AFed v v > Advance Time
e o NAVGaTE | sreaconTs o
? e = —
e © x| Workspace
&)=/} « LocalDisk(C) » DSKWork » DSKADS2015.09 » HSDDG » Ethemet » QALEthemet » MyWorkspacel_wrk » data <[ %[ Search data 5| e
@ Organize Newfolder g
=x
P “ Name Date modified Type Size £
B Desktop ] CoM_Thruskp 10872005 1015 AM_ Sip File
 Downloads L] COMNEXTstp
41 Recent Places = [ COMFEXTstp
DK Work L il UtrsScale GTY_Ro Package.sip
DSK_ADS 2015.09 ) X UlraScale_ GTY_Tx Package.sdp
QA Home rameshpl ] Biind_Via_modelseparate_antipad.sép

£ 1P Work(5CB30831PG)
Customer Testcases PI
ADS Builds 2015

L for share (ENBLu)
HSD_CTB Designs Ethernet
SIPLQA Home Direct8RD

File name: COM_Thrusdp

Command Window

Your MATLAB license will expire in 23 days.
Please contact your system administrator or
MathWorks to renew this license.

>> com_iees8023_93a
COM tool for PE02.3bj Draft 3.2/P802.3bm Draft 2.2 (SRevision: 1.54 §)

This is not an official IEEE document.

Annex 93A is normative for some implementations. This code is a sample implementation of Annex 93A and is not normative.
Enter config XLS file or return will just pop a window to ask for the XLS file]:

How many FEXT channels are to be entered? [return is means no FEXT] 1

How many NEXT channels are to be entered? [return is means no NEXT] 1

e

® After loading the required files, the software initiates simulation and displays the following results for KP4 - COM

analysis.
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Channel Simulation

The following design shows the end to end simulation of KP4 channel and generates eye diagram.

Blind_Via modsl_Separate_Antipad
TX_BGA_Package g
126

Blind_Via model_Separate_Antipad
schematic

Transmission_Line: SingleTrace

Transmission: Line_SingleTrace
30

B e [

[ RX AMI

TCAMI
T 11 ¥
IbisFile="Tx_PAM.ibs" SnP R)LAMH” .
ComponentName="Tx PAM" & o "?;;TN:%JP;, PAM"
b= PNanes2p
jelName="Tx. " on "
SetAllData=yes gﬁﬂ:’éi‘“ .:x A
etal sl DmTypeSe\Yecmﬂyp
sehKs, fes UsePkg=yes
i EED HDF5 waveform generation:
ThannelSim
ChannelSimt
NumberOfBits=1000
ToleranceMode:
EnforcePassivity=yes =
Mode=Bit-by-bit
E
Note: Note: The Design uses 3 tap FIR filter with Co-efficients "-0.05 0.94 -0.01" and CTLE with gain of 15 dB and Poles of "-9¢9 -30e9"
To generate HDF5 for this schematic, please activate all variable at "HDF5 waveform generation™ box.
The following parameters that are plotted in the results:
ADS
measurement Summ ary
‘WidthAtBERO 3.005E-11
N—O ‘WidthAtBER1 3.274E-11
555 WidthAtBER2 3.245E-11
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